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YEStation Limited Warranty 
 

General Terms and Conditions 
 
LIMITED PRODUCT WARRANTY. Affirmative Technology Group warrants that the YEStation Hardware 
Product shall be free from defects in materials and workmanship that arise under proper and normal use and 
service for three years from the date of purchase. A warranty extension of two years is available at extra cost, if 
obtained at the time of the original YEStation purchase. In the event that the YEStation Hardware Product fails 
to comply with the warranty set forth above, Affirmative Technology Group will repair or replace the Product. 
Note: Advanced Replacement for warranted units is only available for user sites in the United States and Canada. 
 
 
SOFTWARE WARRANTY. Affirmative Technology Group warrants that, for a period of ninety (90) days 
from the date of purchase by the End User, its Software Products shall conform to its published specifications 
under normal usage. AFFIRMATIVE TECHNOLOGY GROUP DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT ALL 
SOFTWARE DEFECTS WILL BE CORRECTED. In the event that a Software Product fails to comply with the 
warranty set forth above, Affirmative Technology Group will replace the product. End User must, however, 
return all copies of the Software, along with proof of purchase, to Affirmative Technology Group within 90 days 
from the Software purchase date. 
 
 
WARRANTY LIMITATIONS. End User’s sole remedy under any Warranty provided by Affirmative 
Technology Group shall be limited to the replacement or repair of the Product or, at Affirmative Technology 
Group’ sole discretion, a refund of the purchase price. AFFIRMATIVE TECHNOLOGY GROUP GRANTS NO 
WARRANTY, EXPRESS OR IMPLIED, OTHER THAN THE WARRANTIES STATED ABOVE. 
EXPRESSLY EXCLUDED ARE THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL AFFIRMATIVE TECHNOLOGY GROUP BE 
LIABLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INSTALLATION COSTS, 
LOST REVENUE OR PROFITS, OR ANY OTHER COSTS INCURRED AS A RESULT OF THE USE OF 
ANY AFFIRMATIVE TECHNOLOGY GROUP PRODUCT, WHETHER OR NOT USED IN ACCORDANCE 
WITH INSTRUCTIONS. 
 
 
WARRANTY PROCEDURE. Affirmative Technology Group will replace or repair any defective, undamaged 
units for which a Return Material Authorization number (RMA#) has been obtained from the Technical Support 
Department. (Contact 855-437-1220 or 602-437-1220 or support@affirmativetg.com) 
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Copyright and Trademarks 

 

Copyright Notice               
This manual, as well as the software described in it, is furnished under license. No part of this publication may be 
reproduced, transmitted, stored in a retrieval system, or translated into any human or computer language, in any 
form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the 
prior written permission of the copyright owner. 
Note: Information in this document is subject to change without notice.  

 
 

Trademarks Notice  

 YEStation® is a registered trademark of Affirmative Technology Group® 
 Microsoft® is a registered trademark of Microsoft® Corporation.  
 Windows® is a registered trademark of Microsoft® Corporation.  
 ICA® is a registered trademark of Citrix® Systems Inc.  
 MetaFrame® is a trademark of Citrix® Systems Inc.  
 Adobe®, the Adobe logo, Acrobat®, the Acrobat logo, and Acrobat Reader are trademarks or registered 

trademarks of Adobe Systems Incorporated. 
 Ericom® and PowerTerm® are registered trademarks of Ericom® Software Ltd. 
 Other company and brand, product and service names are trademarks or registered trademarks of their 

respective holders.  
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Installing Your Terminal 
 

 
 

Installing Your Terminal 
 

 22x7 and 23x7 terminals are no longer in production, and their physical characteristics are not discussed in 
the manual. However, their user interfaces and firmware capabilities are very similar to those of the 2417 and 
27x7 terminals—identical for most software-dependent functions—so this manual is still pertinent for these 
older terminals. Please contact Affirmative Technical Support if you have any questions about the slight 
operational differences. 

 Your terminal has no internal fan, and relies on natural airflow for cooling. When you mount it, make sure to 
keep as many ventilation holes, as possible, unobstructed. 

 DO NOT USE any AC-DC adapter other than the one provided with the terminal or acquired from 
Affirmative Technology Group or its distributors. 

 
 

Mounting 
 

 
Horizontal mounting will obstruct the airflow required to cool the terminal. These terminals can either be 
mounted vertically on a flat surface, using the provided stands as shown in the picture on the front cover of this 
manual, or on the rear of LCD monitors using optional VESA mounting plates as shown here. Such a plate can 
be attached to most of the current crop of LCD monitors, as shown in the following figure. 
 

 

VESA Mounting Plate on a 17” LCD Monitor 
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241x Mounted on an LCD Monitor 

 
 

273x Mounted on an LCD Monitor 

 

 
 
 
 
 
 
 

Cabling and Indicators 
 

241x 
 
Please make all cable connections before turning on the power. The 241x has the following controls and ports: 
 Power Switch (front) 
 USB (two front and three rear) 
 DVI-I (rear) 
 RJ-45 LAN (rear) 
 Printer Parallel (rear) 
 Serial (two rear) 
 Earphone Output (rear) 
 Microphone Input (rear) 
 16V DC Power (rear) 
 Kensington Lock (knockout in left rear) 
 
There are three LED indicator lights: 
 Power. The translucent Power button serves as the Power indicator. This indicator turns blue when the 

terminal is powered up. 
 Network Connection. This amber indicator at the upper right corner of the RJ-45 Ethernet connector is on 

when there is a good physical connection to the Local Area Network. 
 Network Activity. This green indicator at the upper left corner of the RJ-45 Ethernet connector flashes to 

indicate LAN activity. 
 

273x 
 
Please make all cable connections before turning on the power. The 273x has the following controls and ports: 
 Power Switch (front) 
 USB (two front and three rear) 
 DVI-I (rear) 
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 VGA (rear) 
 RJ-45 LAN (rear) 
 Serial (two rear) 
 Audio Output (rear) 
 Earphones Output (front 
 Microphone Input (fear) 
 16V DC Power (rear) 
 Optional PCI-e or Two Additional Serial (rear) 
 Kensington Lock (knockout in left rear) 
 
 
There are four LED indicator lights: 
 Power. The translucent Power button serves as the Power indicator. This indicator is faint amber when AC 

power is connected at the rear connector, and turns green when the terminal is powered up. 
 Network Connection. This amber indicator at the upper right corner of the RJ-45 Ethernet connector is on 

when there is a good physical connection to the Local Area Network. 
 Network Activity. This green indicator at the upper left corner of the RJ-45 Ethernet connector flashes to 

indicate LAN activity. 
 Flash Memory Activity. This green indicator flashes when there is read or write activity to the flash 

memory. 
 
 

Power On and Boot Up 
 

These terminals can be powered on in two ways: 
 Locally by pushing on the Power switch on the terminal. 
 Remotely using eProManager remote central management software and the Wake on LAN capability of the 

terminals. 
In either case, the process is: 
1. Turn on the terminal after all rear panel connections have been made. 
2. The translucent Power button will change from faint orange to light green. 
3. You will briefly see the message Starting System. Please Wait … on a black screen. 
4. After several seconds, you will see the Windows XP Embedded startup screens which look very much like 

your desktop Windows XP startup screens. 
Note: If you wish to access the terminal BIOS, press F2 at the beginning of the bootup cycle. 
 

Shutdown 
 

These terminals should be shut down gracefully in typical Windows XP fashion by going to Start>Turn Off 
Computer. 
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XPe Limitations 
 
 

 
 

XPe LIMITATIONS (Read this 
Section) 

 
Your terminal is pre-configured with the Windows XPe (XP Embedded) operating system and a minimal set of 
applications. If you are familiar with Windows XP on your desktop or laptop PC, you are familiar with Windows 
XPe. In general, you can install the same applications or peripherals on this terminal as you can on Windows XP, 
subject to memory and I/O port restrictions. However, primarily due to the limited amount of flash memory for 
program storage, THERE ARE SOME LIMITATIONS. 
 
 XPe uses a utility called EWF (Enhanced Write Filter) Utility to control write access to the flash memory. If 

Write Protect is enabled, configuration changes can be made and new applications or peripheral drivers can 
be installed, but these modifications will not be saved after a reboot unless a special operation is executed, 
before the computer is turned off, to save them in non-volatile memory. This operation is called Write Filter 
Commit, and you can learn more about it at Configuring Terminal Properties|Administrator Control 
Center|Control Panel|EWF Manager. This protects your terminal from viruses, malware, and user games. If 
Write Protect is disabled, changes, new applications, and bad stuff will automatically be saved in flash. XPe 
users are separated into two classes: computer administrator, and limited; limited users cannot execute any 
operation from the EWF Utility. So remember that changes made by limited users or Internet hackers will 
not survive a reboot unless Write Protect has been disabled by a user with computer administrator privileges. 

 
 XPe is designed for a minimal memory footprint. It is possible to generate an XPe configuration that has the 

same full, rich feature set as XP Professional, but this would then require, for installation, the same large 
amount of non-volatile storage space that is required for XP Professional. In your PC, you have many 
Gigabytes of non-volatile storage on a hard disk; in your XPe terminal, you have 256-4,096 Megabytes of 
non-volatile flash storage to hold the XPe operating system and your choice of applications. 

 
 When the software image is first created for an XPe terminal product, the developer chooses from a laundry 

list of XP features, trying to anticipate which ones are most likely to be required by the bulk of the terminal 
users. This restricted feature set is probably most likely to be noticed in the Windows Control Panel; you will 
see many, but not all, of the standard XP control utilities. Furthermore, within each utility you will probably 
not find all of the configuration parameters that you would find in XP. See Configuring Terminal 
Properties|Control Panel for information on the typical Control Panel. 

 
 As mentioned above, you can generally install and run the same applications on your XPe terminal that can 

be installed on an XP PC, if there is enough volatile and non-volatile memory. But be aware that some 
applications assume the availability of standard XP modules that may not have been included in your XPe 
set. For instance, some applications require the Visual Basic Run Time Library, which is not included in the 
YEStation XPe module set. Therefore, these applications might install on the terminal, but they will not run. 
Unlike XP, which allows the installation or removal of some XP features in the field, XPe modules must be 
configured at build time; they cannot be added or removed in the field. 
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 If you are using Remote Desktop Protocol to access a Terminal Server, there is a further distinction between 
computer administrator rights and limited user rights. A limited user cannot store Terminal Server license 
information in the Registry, but a computer administrator can store such information. Hence a limited user 
using local rights cannot open an RDP session unless a computer administrator has already obtained a 
Terminal Server license for the terminal. See Configuring Terminal Properties|Administrator Control 
Center|Control Panel|EWF Manager.for more information on this subject. 

 
This user guide will assume that the user or administrator is familiar with XP administration and/or use as 
encountered on a PC. Therefore, this document will concentrate on those aspects of XPe which are significantly 
different from XP Professional. 



Configuring Terminal Properties 
 

 
 

 

Configuring Terminal Properties 
 

 
Almost all of your terminal properties are configured from the Start window, but several require the use of the 
Affirmative Technology Group remote central manager, eProManager. 
 

 

Start Window 

Configuration changes and printer additions are initially stored in RAM. In order for these changes to be written 
permanently into non-volatile flash memory, thereby surviving a reboot, Write Protect must be disabled for the 
flash, or a Commit operation must be executed. See Administrator Control Center|Control Panel|EWF Manager 
for an explanation of the EWF (Enhanced Write Filter) utility, which provides Write Protect control. 
 
Printers and Faxes provides the usual set of Windows printer configuration capabilities, allowing you to add a 
local or network printer as well as configure existing printers. No more will be said about it here. 
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Control Panel 
 

Most terminal properties are configured in Control Panel. 
 

 
 

Control Panel 

As you can see, the YEStation build of XPe does not include all of the configuration utilities available in XP. 
This is generally the case in XPe, since each build is custom built to minimize memory footprint based upon 
expected customer usage. Also some utilities may not have all of the property parameters available in XP. 
  

Administrator Control Center 
 
Several properties are configured in Administrator Control Center, which is reached from Start>All 
Programs>Administrator Control Center. You will first see the Login dialog box. 
 

 

Administrator Control Center Dialog Box 

The default password is “guest”, but you can change that here by clicking on the Change button and following 
the dialog box. This same password is also used for the EWF Manager Utility. When you enter the correct 
password and click on Login, you will see the Administrator Control Center Properties-General window. 
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General 

 

Administrator Control Center General Properties 

Several of these general properties merit discussion. 
 Product ID. The last twelve characters are a permutation of the MAC address. 
 Software Version. This information is useful when seeking technical support from Affirmative Technology 

Group. 
 RAM Size. This is the remaining RAM after the Z drive has been allocated. See Control Panel|RAM Disk 

for more information.. 
 ROM Size. This is the approximate size of the flash memory. In the above example, the installed 

CompactFlash is 512MB. 
 Client Name. This is the “friendly” network name seen by remote central management software and any 

network administration software. Enter a name that is meaningful to your network administrator. 
 

ControlPanel 
 

You must be in the administrator group to access any of the utilities in ControlPanel. Several important 
configuration utilities are accessed from this window. 
 

 

Administrator Control Center ControlPanel 
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Configuring Terminal Properties 
 
These utilities are separate from the standard Control Panel because their significance typically calls for the extra 
security provided by the password login and restriction to administrators. 
 
Note: If you make any changes using any of these five utilities, you will see the following information box when 
you OK out of Administrator Control Center. 
 

 

Commit Information Box 

 
If you want to save the changes into flash memory for use after the next reboot, be sure to click on Yes. See EWF 
Manager for more information on writing into flash. 
 

Auto Login 

 
 

Despite the restrictive title, this utility also provides extended control of user accounts. 
 

Users 

 

Default User Accounts 

New users can be added here or in Control Panel>User Accounts. But several user properties can only be 
controlled from this utility. These properties are better illustrated if several users have already been added, as 
shown in the following dialog box. 
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Additional User Accounts 

 Users must enter…. Check this box if you want user password control. But this control only exists for users 
that have been assigned passwords, and you can only assign passwords here in User Accounts. You can do 
this in one of two ways: 
o Add a new account here (click on Add and follow the Wizard) and define a password in the Wizard. 
o Add password control to an existing user by highlighting that user in the user list, clicking on Reset 

Password, and entering the password in the resulting dialog box. Note: You cannot change the password 
for the current user, despite the instructions to press Ctrl+Alt+Del. 

 Users for this computer. This box contains a list of all the defined users. Administrator and Guest are 
default users; the rest have been added. 

 

Add. 
Click on this button to launch the Add New User Wizard. You will be led through three dialog boxes. 
 

 

Add New User Dialog Box #1 

Enter a User Name. This name will automatically be entered into Full Name, but the Full Name can be changed 
if you wish. The Full Name is the name you will see when you boot the terminal and arrive at the iconed Logon 
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screen. If you want to enter some information about this user for future administrative clarification, enter it in the 
Description field. 
 

 

Add New User Dialog Box #2 

Enter and confirm a password if desired. If you want this user to auto logon (see Automatic Log On), you must 
enter a password. 

 

 

 

Add New User Dialog Box #3 

Here is the interesting stuff. If you add a user through Control Panel>User Accounts, you have only two 
selections for the type of user, computer administrator (shown here as Administrators) and limited user (shown 
here as Restricted user or Users). But here you have additional options of Guests and Standard user (or Power 
Users). You also see several other options if you select the Other radio button and access the drop-down list as 
shown in the above dialog box, but they are holdovers from another world and have little or no use here. 
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Properties 
Click on this button to change the properties of an existing account. You can access two dialog boxes. 
 

 

User General Properties Dialog Box 

You can see that this dialog is a duplicate of the first dialog box encountered when adding a user. 
 

 

User Group Membership Properties Dialog Box 

This dialog is a duplicate of the final dialog box encountered when adding a user. 
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Reset Password 
Click on this button to change the password for the highlighted user. 
 

 

Reset User Password Dialog Box 

This dialog is a duplicate of the second dialog box encountered when adding a user. 
 

Automatic Log On 
You can designate one user to be automatically logged on when you boot the terminal. To do this: 
1. Highlight the desired user in the Users list. 
2. De-select the Users must enter… box. 
3. Click on OK or Apply. You will see the following dialog box. 
 

 

Auto Logon Dialog Box 

4. Enter the information for the user. You can change the user name here if you wish. Note: You can enter a 
user name that is not in the User list, but the terminal will do strange, undesirable things on boot up. 

5. Click on OK. 
 

EWF Manager 

 
 
Enhanced Write Filter (EWF) may be the most visible difference between XPe and XP, at least from an 
administrator’s point of view. Flash memory (the c drive) is treated as a protected volume, and the protection 
must be disabled or a specific action must be taken in order to commit software, file, and configuration changes 
to flash. EWF is the utility that controls flash protection. 
 
There are several reasons why you may want to write into flash memory.  
 You have transferred files into your 2xx7 and want to save them for future use after a Power Off or reboot. 
 You have made configuration changes, such as those made via Control Panel, and want to retain them after a 

reboot. 
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 You have installed new application programs or device drivers and want to save them for future use after a 

reboot. 
 You have signed on to a Terminal Server for the first time and want to save the TSCAL information. 
 You are participating in a Domain and want to save the Domain Secret Key. 
 
When flash write protection is enabled, changes, new software, etc. are written into a RAM overlay. The contents 
of this overlay can be written into flash, as shown below. But if the contents are not written into flash, they are 
lost when the terminal is rebooted. If write protection is disabled, changes, new software, etc. are written 
immediately into flash and are still available after a reboot. 
 
Click on the icon to open the following dialog box. 
 

 

EWF Manager Dialog Box 

 Write Protect On/Off. These two radio buttons show the current status of EWF. 
o Enable Write Protect. If this radio button is active, the flash memory is write protected (EWF is 

enabled). This is also an action button; If the Disable Write Protect button is active (EWF is disabled), 
you can switch to a protected state by clicking on Enable Write Protect and closing the dialog box. 

o Disable Write Protect. This is a status button only. If this radio button is active, the flash memory is not 
write protected (EWF is disabled). If you try to switch from the protected state to an unprotected state by 
enabling this button and closing the dialog box, subsequent disabling action appears to be occurring. 
However, after the requested reboot (see below), you will find that nothing has changed, and the status is 
still Disabled. 

 Write Filter Control. In addition to the enabling action provided by the Enable Write Protect button, you 
can initiate two other actions here. 
o Commit. Click on this button to commit the overlay contents to flash. You will see the following 

information box 

 

EWF Commit Information Box 

This box is for information only. It is not asking for your approval, so the commit will take place 
regardless of whether you click on OK or X. 

o and Disable. If you make this selection and then close the dialog box without clicking Commit, the 
result is the same as if you had clicked on Commit by itself, except that you will not get the EWF 
Commit information box. The overlay contents are committed to flash, but write protection is not 
disabled. 

o Commit and Disable. The only way to disable write protect is to select and Disable and then click on 
Commit. 

 Clear the current…. This button has no effect. 
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 Hide. If you click this button, the dialog box will disappear, but you can still access it by clicking on the icon 

in the System Tray. 
 Close. Click here to close the EWF dialog box. If you took action to enable or disable write protect, that 

action will not actually take place until you reboot your terminal, as you will be reminded by the following 
information box. 

 

Restart Information Box 

There are two other ways to access the EWF utility. 
 Enter from Start>All Programs>EWF. You will have to enter the EWF password to gain access. Even a 

non-administrator can gain access this way and appear to make changes after going through all the boxes. 
However, after reboot you will see that the changes never occurred. 

 Use the command line interface from Start>Run>Cmd. In this case, no EWF password is required. 
However, the EWF commands will be executed only for administrators. Here are the available commands. 
o ewfmgr c:  This command gives you the current protection state, DISABLED or ENABLED, of the C 

drive. 
o ewfmgr c: -enable  This command enables protection after the next reboot. 
o ewfmgr c: -commit  This command commits, at this point in time, any new files, software, and 

configuration changes to flash without regard to the protection state. 
o ewfmgr c: -commitanddisable  This command commits, at this point in time, any new files, software, 

and configuration changes to flash without regard to the protection state, and then disables protection 
after the next reboot. 

 

Security 

 
Click on this icon for another opportunity to change the Administrator Control and EWF Manager password. 
You will see the following dialog box. 
 

 

Change Password Dialog Box 

The entries are self-evident, but there is one eccentricity. Even if your only desire is to disable the password, this 
utility still demands a new, confirmed password before disabling. 
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RAM Disk 

 
 

Click on this icon to adjust the size of the RAM disk. 
 

 

RAM Disk Dialog Box 

 

Outlook Express Maintenance 

 
Your Outlook Express maintenance options are very limited. Click on this icon to open the following dialog box. 
 

 

Outlook Express Maintenance Dialog Box 

Your only maintenance option is to specify the storage location for your personal messages. If you click on the 
… button, you will be able to browse available storage options, including USB and network storage. 
 

FTP Upgrade 

 
Click on this icon to see the Firmware Upgrade dialog box. If you have an FTP host somewhere on your network, 
you can pull down and install a new image file from that host. This new file will replace the current contents of 
the terminal’s flash memory, and all configuration parameters will be set back to default. 
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Firmware Upgrade Dialog Box 

1. Enter the parameters for your FTP server, as instructed by your network administrator. 
2. Click on the File dropdown arrow to see the available image files at that server. 
3. Highlight the desired image file. 
4. Click on Upgrade. The image will now be upgraded without any further required interaction. 
 
If you have Affirmative Technology Group’ remote management software, eProManager, installed on your 
network, you can execute this same procedure from that management console, rather than having to be on site. 
Using that software, you can schedule the procedure to occur automatically at a convenient time, if you wish. 

 
 

USB Port 
 

 
This applet controls the use of USB storage. Click on this icon to see the USB Storage Control dialog box. 
 

 

USB Storage Control Dialog Box 
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For security reasons, you may want to avoid files being removed from your unit by disabling USB storage. 
Ignore the Read-only USB Storage check box, since this option does not work. If you enable USB storage, the 
user will be able to copy files to the USB drive. 
 

USB Clone/Restore 

 
This applet allows you to clone the current image to a USB drive and restore that image to any XPe thin client 
with the same hardware configuration. See Cloning a 2xx7 YEStation XPe Image for cloning/restore details. 
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Configuring PowerTerm Sessions 
 

 

Configuring PowerTerm Sessions 
 

Configuring a New Session 
 

Configuration of a new session begins at the PowerTerm Connect dialog box. To open this dialog box, click on 
the PowerTerm icon on the Desktop. 

 
This will open the PowerTerm Connect dialog box. The first time that you open this dialog box, you will 
probably see four pre-defined TN5250 display sessions in the Sessions List—101GREEN, 101GUI, 
122GREEN, and 122GUI. These sessions are configured to use the most-common properties of the PowerTerm 
green screen or graphical user interface alternatives. As is obvious, there are two sessions configured for use with 
the Affirmative Technology Group 101-key 5250/PC keyboard and two for use with the Affirmative Technology 
Group 122-key 5250/PC keyboard. Before configuring a new TN5250 display session from scratch, we suggest 
that you explore these pre-defined sessions. They are configured to access, over the Internet, the Affirmative 
Technology Group demo system with User Names and Passwords of DEMO1 through DEMO5. 
 
This section will explain the parameters in enough detail to get you started and connected. For many users, this 
may be all that is needed. For detailed information on configuring and operating PowerTerm sessions, please 
consult the PowerTerm XPe User Guide at http://www.affirmative.net/pub/PtSeriesXPeUsersGuide8_1.pdf. 
 
The Connect dialog box allows you to set basic configuration parameters—those that will allow you to make a 
connection to your host. If you decide that one of the pre-defined sessions will, with some editing, meet your 
needs, set the basic parameters here. In this section, we will also show you how to configure TN5250 sessions.  
 

 

Default PowerTerm Connect Dialog Box 
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Configuring PowerTerm Sessions 
 
 Terminal Type. Select a terminal type from the lengthy drop-down list. When you do this, the fields in the 

dialog box will change to reflect the basic attributes of that terminal type. 
 

Display Session Configuration 
 
 If you choose the 5250 Display type in the default Connect box, it will change to  
 
 

 

5250 Display Connect Dialog Box 

 Terminal ID. For each terminal type, there are usually a number of specific models that can be emulated. 
Choose your desired model here. The default 3477-FC is probably the most popular 5250 terminal model 

 Session Type. The list of available session types will vary depending upon which Terminal Type you select. 
For a 5250 display session, use the TN5250 session type. 

 Host Name. Enter an IP address, unless the host system name is defined in a DNS server. Each emulator 
session can have a different host if desired. 

 Device Name. Enter the session name recognized by the host if you are using named sessions. For a printer 
session, it will probably be a named session as defined by your server administrator. 

 Auto SignOn. This parameter is not available at this time. 
 Port Number. This parameter will default to the common TCP port, so, unless you are instructed otherwise 

by your network administrator, you generally do not need to enter anything here. 
 Keep Alive Timeout. If you want to ensure that your session connection is kept alive during periods of 

inactivity, put a number of seconds here. This is especially useful if you are using a slow WAN link to a 
remote server. 

 Security Type. If you want a secure connection, and your host supports it, select the type of security from 
the drop-down list. When you make a selection, the Details button will be activated. Click on this button and 
enter security configuration details in the resulting dialog box. 

 Setup File. If you want to clone the parameters of a previously-defined configuration, click on the … button 
to the right of the this field. You will see a browse window with a list of configuration (setup) files with the 
.pts extension. Select the file for the configuration that you wish to clone. 

 

22 



Configuring PowerTerm Sessions 
 

 

Setup File List 

 Script File. If you want to automatically invoke a previously-constructed script at session startup, click on 
the … button to the right of this field and select a script file (.psl) from the resulting browse window. In this 
example, there is only one existing script, StartOrder.psl, which has been constructed to establish the 
starting order of a number of AutoStart PowerTerm sessions (see  Autostarting Powerterm Sessions in a 
Specific Order). 

 

Script File List 

 Save As…. You will probably want to save all the parameters of this connection for future use. If so, click on 
this button and enter a connection name in the Save Session window. This name will appear in the Sessions 
List and the session will be saved for future use. 

 Connect. If you want to connect immediately, click on this button. Otherwise, you can click on Close or X 
and the connection will be saved for future use. 

 Rename. Click on this button if you want to change the name of a session in the Sessions List. 
 Modify. Click on this button if you have made some changes to an existing session in this dialog box, and 

you want to save those changes. 
 Delete. Click on this button to delete an existing session. You will be asked to confirm your action. 
 Close. Click here to close this dialog box. 
 Help. On-line help is not available at this time. 
 
This takes care of the basic configuration parameters. To select other configuration options, typically for look 
and feel, you will need to open (connect) the session. 
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Terminal Setup 
 
After entering the basic configuration parameters for a display session, you can open that session and get a sign-
on screen. But you can complete these additional configuration parameters even without the sign-on screen. 
 
Open the Terminal menu and select Setup. You can also click on the Setup button in the Tool Bar. 
 

 

Setup Icon 

You will see the Terminal Setup window open with six tabbed dialog boxes. Ignore the Emulation box; you’ve 
already made your emulation choice in the basic configuration. 
 

 

Emulation Dialog Box 

NOTE: After making any configuration changes, you must save your new Terminal Setup before you close 
the session – otherwise they will be lost. This can be done in several ways depending upon the parameters you 
have chosen (see Preferences). In addition to doing this at session exit time, you can do it proactively at any time 
from the File menu by executing Save Terminal Setup. After you do this, these selections can be transferred to 
any new or existing connection by selecting that setup file when configuring the connection. If you do not do a 
Save, you will lose all these changes. 
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General 
 

 

General Dialog Box 

Most of the parameters in the General dialog box are self-explanatory. Here are explanations of the others. 
 
 Power GUI. Check this box to convert a standard Green Screen look to a graphical look as shown here. 
 

 

Power GUI Screen 

The menu items and the F button callouts are automatically appear as action buttons which can be activated 
by a cursor left-click. 

 Show Frame. Click on this box to put a silver frame around a Green Screen display. You cannot put a frame 
around a Power GUI screen. 
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Framed Green Screen 

 Unscaled Screen. This option only applies to a framed screen. When it is checked, scaling a framed screen 
does not scale the Green Screen portion of the display. So you might get something that looks like this. 

 

 

Unscaled Green Screen 

 Code Page. If you are in the US, leave the code pages at their default settings. 
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Keyboard 
 

 

Keyboard Dialog Box 

These parameters are self-explanatory, except for: 
 Caplock Mode, 

o Caps (Unix), locks alphabet keys on main keypad in uppercase. 
o Shift, locks alphabet and numeric keys on main keypad in shift setting. Pressing the 

shift button on your keyboard will release shift-lock mode. 
o Reverse (Win), Same behavior as Caps Lock, however pressing the shift button on your 

keyboard reverses the caps operation. This is the recommended mode for users who 
are familiar with Windows applications. 

o Always On, enables you to toggle to a different application and turn Caps Lock mode off. 
On return to PowerTerm WTC it will automatically revert to Caps 

 

Printer 
 

 

Printer Dialog Box 
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This dialog box is identical to the dialog box used when setting up a printer session. In display session 
configuration, it is intended to configure a printer for local Print Screens. If the Print Screen Data Conversion is 
set to Graphic, this configuration function, except for printing to a file, is usurped by the Windows Add Printer 
Wizard. Using this wizard, accessed from the Print Setup option in the File menu or from the Printers and 
Faxes utility in the Windows Start menu, you can configure a parallel, serial, USB, network, or LPR printer. You 
can add multiple printers on different ports; then choose the desired printer in the File>Print Setup dialog box 
when you wish to do a local print (Print Screen). 
 
If you wish to print to a file, select File from the Print Device drop-down list. This will activate the Device 
section as seen here. 

 
 

Enter the desired file name, including the complete path, in the Device Name field. Then select whether to 
Append or Overwrite in this file. 
 
If you choose None in Print Screen Data Conversion, and Device in Print Device, you must specify a port in 
Device Name. Although the default is lpt1, and you are given no other choices, you can type in com1 for the 
local COM port or com2 to select the USB port. You are now dependent upon a PowerTerm printer driver, which 
you can select by clicking on Advanced Printing, as shown here. 
 

 

Advanced Printing Dialog Box 

Select a printer from the Printer Type/Model drop-down list, and adjust other available parameters if you wish. 
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Colors 
 

 

Colors Dialog Box 

This dialog box allows you to customize the visual properties of the emulation screen attributes. You can also 
customize the colors for several other items seen at the bottom of the Select Attribute drop-down menu, shown 
here. 
 

 
 

Preferences 
 

 

Preferences Dialog Box 
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 On Terminal Setup…. Ignore this section. 
 History Buffer Size. This parameter is valid only for non-IBM emulations. 
 Window Title. Type in the “friendly” title that you wish to see in your Desktop Task Bar. 
 History Buffer. This buffer is used only for non-IBM emulations. 
 On Power Term Exit. This group of parameters defines certain actions that can be taken when the session is 

exited. 

o Save Terminal Setup. If you changed the terminal parameters during the session, the changes are 
automatically saved to the current terminal setup file. 

o Confirm Save. If you check this box, any changes in terminal parameters are not saved automatically 
when you exit the session. PowerTerm displays a dialog where you can decide whether or not to save 
any changes to the current terminal setup file. You can check either this box or Save Terminal Setup, 
but not both. If you leave both unchecked, changes will not be saved and you will not receive any 
prompt. 

o Save Window Size & Position. This saves the size and position of the emulation window. The next 
time you open this session, the window appears with the desired size at the set position. 

o Confirm Disconnect Session. When you close this session, you will be required to confirm your desire 
to disconnect.  

o Inactivity Timeout. If there is no keyboard activity within the specified time, the session will 
automatically close. Leave the setting at 0 if you do not want a timeout. 

 On Session Exit. These parameters are invoked if the session communication was disconnected. 
o Auto Reconnect. Re-establishes communication if the line was disconnected. 
o Auto Exit PowerTerm. Closes the session altogether on a disconnect. 

 
 
 
Keyboard mapping, Power Pad options, and other miscellany are available under the Options menu. If you 
change the keyboard mapping, be sure to execute a Save Keyboard File from the File menu. 
 
After completing your configuration, click on OK and close or continue this session. 
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Printer Session Configuration 
 
If you choose the 5250 Printer type in the default Connect box, it will change to  
 

 

5250 Printer Connect Dialog Box 

See Display Session Configuration for an explanation of these parameters, except for: 
 
 Message Queue/Message Library. Ask your server administrator about any changes here. 
 

Terminal Setup 
 
After entering the basic configuration parameters for a printer session, you can open that session and get a status 
screen. Now you can complete these additional configuration parameters. 
 
Open the Terminal menu and select Setup. You can also click on the Setup button in the Tool Bar. 
 

 

Setup Icon 

You will see the Terminal Setup window open with four tabbed dialog boxes. Ignore the Emulation box; you’ve 
already made your emulation choice in the basic configuration. 
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Emulation Dialog Box 

NOTE: After making any configuration changes, you must save your new Terminal Setup before you close 
the session – otherwise they will be lost. This can be done in several ways depending upon the parameters you 
have chosen (see Preferences). In addition to doing this at session exit time, you can do it proactively at any time 
from the File menu by executing Save Terminal Setup. After you do this, these selections can be transferred to 
any new or existing connection by selecting that setup file when configuring the connection. If you do not do a 
Save, you will lose all these changes. 
 

General 
 

 

General Dialog Box 

Leave the code page settings at their default settings if you are in the US. 
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Printer 
 

 

Printer Dialog Box 

If the Slave Printer Data Conversion is set to Graphic, this configuration function, except for printing to a file, is 
usurped by the Windows Add Printer Wizard. Using this wizard, accessed from the Print Setup option in the 
File menu or from the Printers and Faxes utility in the Windows Start menu, you can configure a parallel, serial, 
USB, network, or LPR printer. You may also want to use Host Print Transform in the Advanced Printing dialog 
box, as discussed on the next page. 
 
If you wish to print to a file, select File from the Print Device drop-down list. This will activate the Device 
section as seen here. 

 
 

Enter the desired file name, including the complete path. Then select whether to Append or Overwrite in this 
file 
 
If you choose None in Slave Printer Data Conversion, and Device in Print Device, you must specify a port in 
Device Name. Although the default is lpt1, and you are given no other choices, you can type in com1 for the 
local COM port or com2 to select the USB port. You are now dependent upon a PowerTerm printer driver, which 
you can select by clicking on Advanced Printing, as shown here. 
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Advanced Printing Dialog Box 

Select a printer from the Printer Type/Model drop-down list, and adjust other available parameters if you wish. 
 
For the most reliable printing from the host, we recommend that you use Host Print Transform by checking the 
Enable AS/400 Host Print Transform box. This will also enable the configuration parameters in the lower part 
of the dialog box. 
 

Preferences 
 
This dialog box is exactly the same as the one for a display session. See Display Session 
Cconfiguration|Terminal Setup|Preferences for more information. 
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Modifying or Cloning an Existing 5250 
Display Session 
 
Four 5250 default connections are normally provided: 101GREEN, 101GUI, 122GREEN, and 122GUI. As the 
names indicate, each connection is designed to optimize the use of an Affirmative 101-key or 122-key keyboard 
along with a classic “green screen” (text based) or contemporary graphical (GUI) display style. 
 
Each default connection is configured to connect over the Internet to the Affirmative Technology Group 
demonstration AS/400 server. Before you make any modifications, we recommend, if your terminal has an 
Internet connection, that you connect to our server to verify your network configuration and to experience the 
display alternatives. Use DEMO1 or DEMO2 for the user name and password. 
 
It may be convenient for you to modify one of the default connections for your own use, or to modify a 
connection that you have previously created. You can also clone an existing connection in all but name. Follow 
this procedure:. 
1. Click on the PowerTerm icon on the Desktop. You will see the PowerTerm Connect dialog box. 
2. Highlight the name of the connection to be modified or cloned in the Sessions List. The basic configuration 

parameters for that connection will immediately be displayed  
3. Change basic parameters as desired. 
4. Click on one of the following: 

 If you want to clone to a new connection, click on Save As and put the new connection name in the 
resulting dialog box. 

 If you want to retain this connection under the same name, click on Modify. 
5. If you want to change other parameters not found in the Connect dialog box, follow the procedure shown in 

Configuring a New Session|Display Session Configuration. 
 
 

Autostarting a Session 
 
You may want to have your RDP, ICA, or emulation sessions automatically start when you boot up your 
terminal. A session is just another executable program to XPe, so you handle this just like any Autostart program 
on a desktop PC with XP—you move or copy a session shortcut, usually a desktop icon, into the user Startup 
folder. You can create an icon from File>Save As Icon. 
 

Autostarting Powerterm Sessions in a 
Specific Order 
 
When using the standard XP Autostart method, there is no guarantee as to the starting order of the sessions, and 
hence no guarantee as to which session will end up on top (in focus) after the startups. However, there is a way to 
determine start order using the PowerTerm scripting language and a simple Windows delay program provided by 
Affirmative Technology Group. In this case, only the icon for the first session is placed in the Startup folder. 
Then that first session invokes a PowerTerm script which opens the other sessions in the desired order. 
 
An example is shown here using the four PowerTerm default sessions, 101GREEN, 101GUI, 122GREEN, and 
122GUI. In this example we want to start them in reverse order. The first requirement is to create icons for all 
four sessions, as follows. 
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1. Open a session. 
2. From the File menu, select Save As Icon. The Save As Icon dialog box will open 
. 

 

Save As Icon Dialog Box 

3. Enter the icon information as desired. The most important item here is the Setup File Name. Each icon must 
have a unique .pts setup file. 

4. Repeat for each of your sessions. 
 
After creating your icons, continue as follows. 
1. Install two files, delay.exe and MSVBVM60.DLL, in the Program Files\PowerTerm folder, if they are not 

already in that folder. 
2. Open a session. 
3. Select Start Script Recording from the Script menu. 
4. Select Stop Script Recording from the Script menu. 
5. Select Save Recorded Script from the Script menu. The following dialog box will open. 
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Record Script Dialog Box 

6. Unfortunately, Windows wants to default to the My Documents folder. In this case, it is necessary have the 
script in the Program Files\PowerTerm folder, so browse to that folder. 

7. Enter the desired script name, StartOrder in this example, and do a Save. 
8. Select Edit Script from the Script menu. The following dialog box will open. 
 

 

Edit Script Dialog Box 
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9. If this is the only script file in this folder, the name will automatically be placed in the File Name field. 

Otherwise, select the desired script. Then do an Open. A blank Notepad screen will open as follows. 
 

 

Notepad Screen 

10. Enter script commands as shown below.. This example shows a delay of 2 seconds between the openings of 
each session; change this number if you want a shorter or longer delay. Note that you enter the unique .pts 
profile file for each of your PowerTerm sessions that you specified when creating that session’s icon. Also 
note that you enter the information for each session in the order that you want that session to open, except for 
the first session of the opening order. 

 

 

Start Order Script 

11. Save the file. 
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12. Configure the first session, and only the first session, in the opening order to execute this script file, as shown 

here. 

 

Connect Dialog Box 

13. Move the icon for the first session into your Startup folder. 
14. Be sure to execute an Enhanced Write Filter Commit before you reboot, or else you will lose all your work. 
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Now when you reboot, your sessions should start in order, as shown here. 
 

 
 



Cloning a 2xx7 YEStation XPe Image 
 

 
Cloning a 2xx7 YEStation XPe Image 

 
 

The 2xx7 YEStation has the capability to clone firmware images to other 2xx7 YEStations. You can build your 
special Desktop configuration, add applications and peripheral drivers, and then exactly reproduce the resulting 
firmware image on other units. You can create as many unique images as you wish, with the images stored in 
local USB drives or network-share directories anywhere on your network. In this section, the two methods of 
clone/restore will be referred to as local and network. 
 

Requirements 
 
First, two definitions: 
 The benchmark YEStation is the unit on which the desired configuration, applications, and drivers are first 

assembled. 
 The target YEStation is the unit which is to be made identical to the benchmark unit. 
 
YEStations are based on several different hardware platforms, and cloning across different platforms is usually 
not exact. Applications and peripheral drivers should present no problem, but configuration parameters that 
depend upon internal hardware may not be cloned. This is often the case with display parameters, for example. 
For the best and most reliable results, use identical benchmark and target hardware platforms. 
 
Network cloning requires the following elements: 
 eProManager remote central management software, version 3.4a or above, installed on a management 

console on the network. This software can be downloaded from the Affirmative Technology Group web site; 
contact Affirmative Technology Group Technical Support for instructions. 

 Benchmark and target units installed on the same network as eProManager. 
 The network must have a DHCP server. 
 Benchmark and target units to have flash memory of the same size. 
 XPe firmware version 404 or above on the benchmark YEStation. If your benchmark unit does not have the 

proper version, Affirmative Technology Group will provide it on a CD 
 XPe firmware version 301 or above on the target YEStation. 
 At least one shared directory on the network that can be used to store the clone images. This directory 

should be in a Windows PC, not in a unit with a server OS. 
 The YEStation must have a wired connection to the network. Cloning and restoration will not work with a 

wireless YEStation connection. 
 
Local cloning requires the following elements: 
 Benchmark and target units to have flash memory of the same size. 
 XPe firmware version ABC3C or ABC3T or above on the benchmark and target YEStations. 
 USB drive with free space equal to or larger than the flash memory in the units. Note: This is not the size of 

the image, but the total size of the flash. 
 Benchmark and target units must be connected to a network with a DHCP server. Yes, this is a strange 

requirement for local storage, but it is due to using legacy code borrowed from the network procedures. 
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Network Cloning 
 
Cloning consists of two major operations: Capture and Restoration. 
 Capture involves the creating, extracting, and storing of the benchmark image. 
 Restoration involves moving the benchmark image to the target unit and loading the image into the flash 

memory of the target unit. 
 

eProManager 
 
ePro is the central element in image cloning. This remote central management software must be installed on a 
computer on the same network as the benchmark and target YEStations. The installation requirements are: 
 Windows 2000 Professional/Server/Advanced Server with Service Pack 3 or higher, Windows XP 

Professional, or Windows 2003 Server. 
 13MB-20MB disk space. 
 
This document only discusses the particular aspects of ePro that apply to cloning. Complete details on the 
installation and operation can be found in the eProManager User Guide at 
http://www.affirmative.net/pub/eProManagerUserGuide.pdf. 
 
You can download an installation package of the latest version of ePro from 
http://www.affirmative.net/EPROMANAGERV4.8.ZIP. Installation instructions are included in the zip file and 
in the User Guide. 
 

Capture 
 
The capture procedure is: 
1. Create a base benchmark unit with an XPe image of version 404 or higher. 
2. Configure the benchmark unit per your Desktop needs and with all the desired applications and peripheral 

drivers. 
3. Connect the benchmark unit to the same network as your eProManager management console. 
4. Open eProManager and click on SearchNew to find the benchmark unit. 

 

ePro Local System Terminal List 

 
5. Right click on the benchmark unit, to see the context menu. 
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XPe Context Menu 

6. Left click on XPe Cloning to see the Remote Clone Image dialog box. 

 

Remote Clone Image Dialog Box 

7. Enter the information: 
 IP. This is the IP address of the PC on the network that contains the shared directory that will contain the 

captured images. You can use your management console as the server, or you can use any Windows PC 
on the network that allows shared directories. 

 Directory. This is the share name of the directory that will contain the captured images. Do not enter the 
complete path; only enter the share name. 

 File. This will be the name of the captured image file. The extension, .xpz, will be added automatically. 
 User/Password. This is the local user name and password that allows access to the shared directory. 

Note: If the shared directory is in a domain environment, you must use the local User/Password, 
not the domain credentials. 

8. Click on Clone. You should see a confirmation that the remote clone command has been sent. You can now 
close this dialog box if you wish. ePro is now out of the capture loop, with all subsequent interaction taking 
place between the benchmark terminal and the computer that is storing the image files. 
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Remote Clone Image Dialog Box with Confirmation 

9. If you look at the benchmark unit display, you will see the unit shut off and then reboot with a lengthy Linux 
boot dialog. At the end of the dialog, you will see the processing message. 

 

 
 

10. The image capture is a relatively slow process, occurring at about 9MB-50MB per minute, depending upon 
your hardware platform. At the end of this process, the benchmark unit will reboot and you should see three 
new files in your share directory, the desired .xpz image file and two information files (a .res and a .txt file). 
You won’t get much information out of the information files, and they are not subsequently necessary for 
any image processing, so you can safely delete them. You will be using the .xpz file for subsequent 
restoration. 
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Restoration 
 
Your .xpz images can be restored to any target YEStation that has an XPe image of version 301 or above. But 
there are two different methods for restoration, FTP Update or Reseal, depending upon the image version at the 
target unit. Use FTP Update for all target image versions of 301 and above until you get to 404. For versions 404 
and above, you must use the Reseal method. 
 

FTP Update 
 
This method of image updating has been available for YEStation XPe units since image version 301. You can 
execute a pull from the terminal or a push from eProManager. In either case, you must have an FTP server, 
configured to access your shared directory of image files, running somewhere on your network. Most network 
administrators use the FTP server that is a standard feature of Windows servers, but any FTP server will work if 
it is properly configured. FTP server configuration is not covered here. 
 
Only the push procedure from an eProManager management console will be covered here, since it is typically the 
most convenient for network administrators. The procedure is: 
1. Make a copy of your desired benchmark image file and rename it with a .xpe extension. The FTP method for 

XPe terminals only works with .xpe files, but .xpe and .xpz files are identical except for the name. 
2. Open eProManager and click on SearchNew if your target unit is not seen in the terminal list. 
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3. Right click on the target unit, to see the context menu. 
 

 
 
4. Left click on Firmware Upgrade to see the XPe Upgrade dialog box. 
 

 
 

5. Enter the information: 
 FTP Host.. This is the IP address of your FTP server. 
 Directory. This is the name of the directory that contains the captured images. Your FTP server must be 

configured to find this directory. 
 File. You cannot enter anything in this field. 
 Port Num:. The default is 21, a standard for FTP servers. You should not have to change this number. 
 User/Password. This is the FTP user name and password that allows access to the image directory. 

6. Click on the drop-down arrow of the File field to see a list of all the .xpe files in the image directory. 
7. Highlight the desired file and click on Upgrade. The target unit will reboot into a Linux “rescue” sequence 

and re-image itself. 
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Reseal 
 
This method is used to re-image target units that are at image version 404 and above. The FTP method will not 
work with these image versions. The procedure is: 
1. Make sure that your desired benchmark image file has a .xpz extension. If that file has a .xpe extension, 

rename it with a .xpz extension. The Reseal method for XPe terminals only works with .xpz files, but .xpe 
and .xpz files are identical except for the extension label. 

2. Open eProManager and click on SearchNew if your target unit is not seen in the terminal list. 
 

 
 
3. Right click on the target unit, to see the context menu. 
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4. Left click on XPe Reseal to see the Remote Restore Image dialog box. 
 

 
 

5. Enter the information: 
 IP. This is the IP address of the PC on the network that contains the shared directory with the images to 

be restored. You can use your management console as the server, or you can use any Windows PC on the 
network that allows shared directories. 

 Directory. This is the share name of the directory that will contain the restore images. Do not enter the 
complete path; only enter the share name. 

 File. You cannot enter anything into this field. 
 User/Password. This is the local user name and password that allows access to the shared directory. You 

must enter something in the Password field. If your password is blank, enter a character and then delete 
it. Note: If the shared directory is in a domain environment, you must use the local User/Password, 
not the domain credentials. 

6. Click on the drop-down arrow of the File field to see a list of all the .xpz files in the image directory. 
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7. Highlight the desired file and click on Restore. You will see a “Restarting…” message. 
 

 
 
8. If you look at the target unit display, you will see the unit shut off and then reboot with a lengthy Linux boot 

dialog. At the end of the dialog, you will see an “Image restore processing” message. 
9. The image restore is a relatively fast process, occurring at about 80MB-100MB per minute. At the end of this 

process, the target unit will reboot and you should see the Desktop results of the new image. 
 

 

Local Cloning 
 
Cloning consists of two major operations: Capture and Restoration. 
 Capture involves the creating, extracting, and storing of the benchmark image. 
 Restoration involves moving the benchmark image to the target unit and loading the image into the flash 

memory of the target unit. 
 

Capture 
 

1. Make sure that the boot order in your BIOS puts the internal HDD ahead of the USB drive. Access the BIOS 
by toggling F2 at the start of boot-up. 

2. Make sure that your USB drive has enough free space. The cloned image itself probably does not occupy the 
entire flash memory, but the USB Clone/Reseal applet assumes that all of the internal flash will be cloned 
and requires that much free space. 

3. Open the Administrator Control Center Control Panel and make sure that the USB Port applet has USB 
Storage enabled. 
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4. Insert your USB drive. 
5. Open the USB Clone/Reseal applet, click on the Clone tab, and enter a file name in the File Name field. The 

.xpz will automatically be added to the file name when the file is stored. 
 

 
 

6. Click on Clone and watch the action, although that can get quite boring. 
7. The unit will automatically restart, go through a Linux bootup process, and start cloning. This is where it gets 

boring, since all you will see for 10-15 minutes are dancing diagonal lines. 
8. When cloning is complete, the unit will reboot back to the XPe desktop. 
 
Note that the image file obtained this way is exactly the same as the image file that can be obtained over the LAN 
via the cloning process in eProManager. Therefore, you can use this file for Resealing over the network, and 
vice-versa. 
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Restoring 
 

1. Make sure that the boot order in your BIOS puts the internal HDD ahead of the USB drive. Access the BIOS by 
toggling F2 at the start of boot-up. 

2. Open the Administrator Control Center Control Panel and make sure that the USB Port applet has USB Storage 
enabled. 

3. Insert your USB drive. 
4. Open the USB Clone/Reseal applet, click on the Restore tab, and choose the appropriate .xpz; file from the drop-

down list. 
 

 
 

5. Click on Reseal and watch the action, although that can get quite boring. 
6. The unit will automatically restart, go through a Linux bootup process, and start copying the .xpz file into the 

flash memory. This is where it gets boring, since all you will see for several minutes are dancing diagonal lines. 
7. When copying is complete, the unit will reboot back to the XPe desktop. 
 
Note that you can also use this same .xpz file to reseal over the network as described in Network 
Cloning|Restoration|Reseal. 
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Supporting Your YEStation 
 

 
Affirmative Technology Group offers Technical Support services for all the Affirmative products. You can 
access Affirmative Technical Support in one of the following ways: 
 
 via Phone 

o 602-437-1220 
o 855-437-1220 

 via Fax 
o 602-437-1320 

 via E-mail 
o support@affirmativetg.com 
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